
Cascading Style Sheets 
 Using Dreamweaver MX 

In this lesson you will: 
• Create an external style sheet 
• Add styles to an existing style sheet 
• Edit a style 
• Create a custom style 
• Link to an external style sheet 
• Create an embedded style 
• Convert embedded styles to external styles 
• Convert CSS to HTML 

Introduction 
Cascading Style sheets (CSS) enable you to define how type is displayed on your Web pages. 
The term 'cascading' refers to the ordered sequence of styles. A style is a group of formatting 
attributes, identified by a single name. Styles in HTML documents give you a great deal of control 
over text formatting. The advantage of using styles is that when you make a change to an attribute 
of the style, all of the text controlled by that style will be reformatted automatically. You can make 
adjustments on a wide variety of settings from standard HTML attributes such as font, size, color, 
and alignment to unique attributes such as the space between characters (tracking), the space 
between lines (leading), and additional size and font options. 
You can use embedded style - one that is stored inside the document - when you need to format a 
single page; or you can use an external style sheet - one that is stored outside of the document and 
linked to the current page - when you need to control several documents at once in order to keep the 
same style of text formatting on multiple pages. It is ideal to keep the treatment of text consistent 
throughout your site because changes in appearance may give viewers the impression they have 
landed on another site. 
NOTE: Cascading Style Sheets can be one of the most difficult Web design concepts to grasp. As 
you read the following pages, resist the temptation to fling your monitor into the hallway until after 
you’ve followed the exercises, which should help to put all of this tech-talk into context. 

Why Use CSS 
Although HTML alone provides basic formatting options, for text, images, tables, and other Web 
page elements, Cascading Style Sheets have many advantages that make it a superior choice for 
many formatting tasks. In fact, the World Wide Web Consortium (W3C), the organization 
responsible for defining standards for the Web, plans to phase out (deprecate) the <font> tag in 
future versions of HTML in favor of CSS. In other words, upcoming browsers may not even 
understand much of the text formatting you apply with the Property Inspector. But they will 
understand CSS. 
But even if the threat of obsolescence doesn’t motivate you to use CSS, consider this: Style sheets 
offer far more formatting choices than HTML. With CSS, you can format paragraphs as they 
appear in a book or newspaper (the first line indented and no space between each paragraph, for 
example) and control the leading (the space between lines of type in a paragraph). 
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Even better, CSS styles take much less space than HTML’s <font> tag formatting. You can usually 
trim a lot of kilobytes from text-heavy Web pages using CSS while maintaining a high level of 
formatting control. As a result, your pages look great and load faster. 

Why Not Use CSS 
Cascading Style Sheets may sound like a cure-all for HTML’s anemic formatting powers, but you 
may pay a price for their convenience. The first consideration is compatibility. Although the CSS 
standard has been around for some time, not all Web browsers understand style sheets. And among 
those that do, some still don’t always display the style properties correctly. (Netscape Navigator 4 
is the main culprit here). The bottom line is to test your pages that use CSS on various browsers and 
various computers. 

Internal vs. External Style Sheets 
As you create new styles and add them to style sheets, you can then store these style sheets either 
internally, in the Web page itself, or in another file called an external style sheet. 
Internal style sheets appear in the <head> portion of a Web page and contain styles that apply to 
that page. An internal style sheet is a good choice when you have a very specific formatting task for 
a single page; perhaps you want to create styles to format the text and table of a chart that appears 
only on a single page. 
An external style sheet, on the other hand, contains only style – no HTML – and can be linked to 
numerous pages. You can create a single style sheet that affects many pages of your site, creating 
uniform formatting throughout. For instance, you can put a headline style in an external style sheet 
and link that sheet to every page in the site. Every headline on the site will then share the same look 
– instant design consistency! Even better, when you decide to change the color of the headlines you 
only need to edit a single file – the external style sheet – to update all the web pages at once. 
You can create both types of styles sheets easily in Dreamweaver, and you aren’t limited to 
choosing one or the other; a single web page can have both an external style sheet (for styles that 
apply to the whole site) and an internal style sheet (for page specific formatting). You can even 
attach multiple external style sheets to a single page. 

Types of  Styles 
Styles come in several different flavors. The two most common are custom styles and redefined 
HTML tags.  
A custom style is one that you create, name, and attach manually to text or an HTML tag. Custom 
styles work the most like styles in word processing and page layout programs. For example, if you 
want the name of your company to be displayed in bold and red wherever it appears in the text of a 
Web page, you can create a custom style named Company with boldface and red text color 
formatting. You would then select your company’s name on the page and apply this style. 
The other major type of CSS style is called an HTML tag style and applies globally to HTML tags, 
as opposed to individual selections. For example, suppose you wanted to display every Heading 1 
paragraph in the Arial font. Instead of creating a custom style and applying it to every Heading 1 on 
the page, you could create a HTML tag style for the <h1> tag. In effect, you redefine the tag so that 
it’s displayed in Arial. The main benefit of redefining an HTML tag in this way is that you don’t 
have to apply the style by hand. Since the new style says that all <h1> tags must use Arial, 
wherever a Web browser encounters a <h1> tag, it displays the text in Arial, the specified font. 
These HTML tag styles are the easiest way to format a page. For one thing, there’s no need to 
select the tag and apply the style; the page only needs to contain an instance of the tag - <h1> for 
example – that you have redefined. 
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Nevertheless, there are times when only a custom style will do, such as when you want to apply 
different styles to various paragraphs on the same page. Simply redefining the <p> tag won’t do the 
trick; that would affect all paragraphs. Instead, you’d have to create a custom style for each 
paragraph format, and then apply the styles by hand. 
NOTE: You will encounter alternate terms for Custom and HTML tag styles. In the official 
terminology of Cascading Style Sheets, custom styles are actually called classes, and HTML tag 
styles are type selectors. Dreamweaver chooses to use the custom style and HTML tag style 
because they are more descriptive. 

Creating Styles 
You start most CSS-related tasks in the CSS Styles panel, which is the command center for creating 
and using styles. To open it, choose Windows > CSS Styles. 
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Phase 1: Set up the CSS Type 
To create a new style, click the New Style button
The New Style dialog box appears when you begi
Type: Click the appropriate radio button 
for the kind of style you’re creating: 
Make Custom Style – to create you 
own style from scratch 
Redefine HTML Tag – to create a 
HTML tag style that Dreamweaver will 
automatically apply to each occurrence 
of the tag. 
Use CSS Selector – to create a style f
one of the four 

or 
pseudo-classes 

Dreamweaver supports or for any valid 
CSS Selector. 
Name: If you clicked the Make Custom Style bu
Dreamweaver’s bland default name (.unnamed1).
standard Cascading Style Sheet convention. Custo
can only contain letters and numbers. 
If you click the Redefine HTML tag instead, selec
Tag pop-up menu (which appears when you click
If you click the Use CSS Selector button, Dream
pseudo-classes from the menu: a:active, a:visited,
states that links can be formatted, or how it looks 
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the look of the link as the mouse moves over it. This last option works like a rollover image, but for 
text. The problem is that Netscape does not recognize the a:hover style. To use these pseudo-
classes, select each in this order: a:link, a:visited, a:hover, and a:active. 
When you choose the CSS Selector option, you aren’t actually choosing a third type of style. 
You’re entering the world of CSS selectors where you can access even more advanced style types. 
A CSS Selector is simply the instruction that tells a Web browser what it should apply the CSS 
formatting rules to. In fact, HTML tag styles and custom styles, are types of selectors. But there are 
other, more advanced selectors. For example, an ID selector (which always begins with # symbol 
like this: #menu1) lets you create a style that identifies one element on the page. Most people apply 
it to an object that’s controlled by a JavaScript. 
A contextual selector is yet another type of CSS Selector. Contextual selectors let you create a 
‘smart’ style that applies only in certain contexts. For example, you could give a special design to 
the <b> tag, but only when it appears inside a bulleted <ul> list. In this case, the selector would be a 
combination of the two tags; you would type ul b into the Selector box. 
Clearly, CSS selectors can add plenty of power, but also staggering complexity, and their full 
implementation is beyond the scope of this class. 
Define In: Click This Document Only, if you want the styles to apply only to the current Web 
page (that is, an internal style sheet). To create a new external style sheet, choose New Style 
Sheet File from the Define In pop-up menu. This option not only creates a new external CSS file, 
but adds the necessary code in the current document to link to that file. 
TIP: If you create a bunch of internal styles in a particular page, and later realize you’d like to turn 
them into an external style sheet that you can use in other pages, you’re in luck. Dreamweaver has a 
command for this task. Open the page containing the internal styles you want to reuse and choose 
File > Export > Export CSS Styles. A dialog box opens, letting you save the file as an external 
style sheet. 

Phase 2: Defining the Style 
The Style Definition window provides 
access to all the formatting options 
available to you. 
There are a dizzying array of style 
definitions to choose from. Once you’ve 
defined the style click OK. 
Dreamweaver adds the style to the 
specified style sheet, and, if it’s a 
custom style, makes it appear in the 
CSS panel. 
The real trick to creating a style is 
mastering all of the different properties 
available, such as borders, margins, and 
background colors, and then learning 
which ones work reliably in the 
different browsers. 
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Style sheets: Embedded or External 
A style sheet is simply a collection of CSS styles (formatting rules). Style sheets do not appear in 
the CSS Styles panel, but some styles defined within them do. Style sheets are accessed using the 
Edit Style Sheet dialog box: 
The Edit Style Sheet Dialog box can be confusing; it displays the internal styles defined in the 
embedded style sheet but displays only the names of external style sheets, (not the styles within 
them). External style sheets are indicated in the dialog box by the word 'link' or 'import' after their 
names. If you highlight the name of an external style sheet in the list, however, the lower portion of 
the dialog box shows the styles defined within it. 
HTML document. For now, just recognize that any CSS styles stored within an HTML document 
are collectively referred to as an embedded style sheet. The name is really a misnomer; there is no 
separate ‘sheet,’ just an HTML document with extra stuff in it (there can only be one embedded 
style sheet per HTML document). 
Because the embedded style sheet doesn’t have a separate name 
(remember, it’s contained in the same .html file as your HTML code) 
Dreamweaver displays its individual styles in the Edit Style Sheet 
dialog box. Embedded style sheets cannot be shared by multiple 
documents. Therefore, use external style sheets to hold styles that 
you expect to use with multiple web pages. To create an external 
style sheet from existing embedded styles, use Text > CSS Styles > 
Export CSS Styles.
Also note that an HTML document can contain an embedded style 
sheet and also include links to one or more external style sheets. 
 
 
External Style sheets – An external style sheet is a collection of CSS styles stored in a separate 
external .css file. (not an HTML file). You can link to an existing external style sheet using the Link 
button in the Edit Style Sheet dialog box.  
You will notice that there are two 
ways to link to an external style 
sheet using this dialog box’s Add 
As option. Selecting the Link 
radio button causes Dreamweaver 
to use a <link> tag to point to the 
external style sheet you have 
chosen, such as: 

<link rel=”stylesheet” href=”pswiss.css” type=”text/css”> 

Selecting the Import radio button does not copy the external sheet’s styles to your embedded style 
sheet; instead it causes Dreamweaver to use the @import directive instead of the <link> tag to 
reference your external style sheets.  
You will ordinarily use the <link> alternative. In fact, using Text >CSS Styles > Attach Style 
Sheet bypasses the link External Style Sheet dialog box entirely and assumes you want to use 
<link>. 
You should store .css files closest to where they’ll be need. If used in a limited section of your site, 
you may store them in a subfolder near the related .html files. If used for your entire site, consider 
storing them in a folder named CSS within the site’s root folder. 
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Creating External Style sheets 
In this exercise, you will create a new style in an external style sheet by redefining an HTML tag. 
By redefining the heading 3 <h3> HTML tag in this exercise, you are telling the browser that any 
text using the <h3> tag should be displayed with the formatting you specify. 
1. Open the about.html file. The document contains paragraphs, headings, and a definition list. 
2. Place the insertion point within the Compass Adventure Tours heading. Look at the tag 

selector at the bottom left of the document window. You’ll see the HTML tag <h3> that has 
been applied to the heading. The redefinition of the <h3> tag will be the first style you create. 

3. Choose Window > CSS Styles to open the CSS Styles panel.  
4. Click the New Style button at the bottom of the CSS Styles panel. The New Style dialog box 

opens. 
5. In the Type area, select Redefine 

HTML Tag.  
Since your insertion point was within 
the heading when you clicked the new 
style button, the h3 tag is 
automatically selected and shown in 
the Tag selection box. 

6. In the Define In area, select New 
Style Sheet from the drop-down 
menu and click OK.  

 
7. When the Save Style Sheet File As dialog box appears, type lessonstyle.css in the Name 

box and click Save. 
This creates the external style sheet file and opens the Style Definition dialog box for the 
selected h3 tag. In the Style Definition dialog box, you define the way you want your heading 3 
tag to appear. The options you want to select for the next step are located in the Type category.  

8. Select the Type category in the category list on the left side of the dialog box. 
9. Select Arial, Helvetica, sans-serif from the Font drop-down menu. Select 14 from the first 

Size drop-down menu and change the measurement to points in the second Size drop-down 
menu. 

10. Select a medium blue for the color by clicking in the color box, and using the eyedropper tool. 
11. Click OK. The changes you have made are now reflected in the first heading on your page.  
12. Save the file. 

Adding a Style to an Existing External Style Sheet 
When you create an external style sheet for a page, it is attached (linked) to that page. You can add 
new styles to make changes to not only this page but to all pages that use the style sheet. 
1. In the about.html document, place the insertion point within the first paragraph below the 

heading Compass Adventure Tours. You will create a style for all paragraphs on the page. 
2. Click New Style on the CSS Styles Panel. The New Style dialog box appears. 
3. Select Redefine HTML Tag from the Type area.  

Since your first insertion point was within the paragraph, the <p> tag is automatically selected 
and shown as p in the Tag text box. The <p> tag represents paragraph.  
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4. In the Define In area, choose 

.lessonstyles.css from the drop-
down menu, and click OK. 

5. Select Verdana, Arial, Helvetica, 
sans-serif from the Font drop-down 
menu. Select 10 from the Size drop-
down menu and change the 
measurement to points.  

6. Type 16 in the Line Height text box 
and change the measurement to 
points. 

7. Choose a dark blue from the color 
box and click OK. 
Any text that is contained within paragraph tags in the document appears with the formatting 
you defined in the external style sheet.

8. Select the subheading ‘Our Guides’ and repeat steps 3 through 5 to apply a style with format 
attributes of your choice for that heading. 

9. Place the insertion point in the first line of the definition list ‘Jacob Brown -  River Guide.’  
10. In the tag selector, click <dl>. This selects the definition list tag that controls the HTML 

formatting of the text. By selecting the <dl> tag, you will apply formatting to both the 
definition term <dt> and the definition data <dd> at the same time. You also avoid a browser 
difference between Netscape 4.0 and Internet Explorer 4.0. Netscape 4.0 (and later) does not 
display style formatting if you create separate styles for the <dt> and the <dd> tags. Formatting 
the <dl> tag works in both browsers. 

11. Use the above steps to apply a style for the <dl> tag with format attributes of your choice. 
12. Save your work. 

Editing an Existing Style 
You may need to modify the styles that are in an existing style sheet. Editing an external style sheet 
will affect all documents that are linked to it. This is useful because the appearance of text can be 
changed in several pages or an entire site by editing only the 
external style sheet. 
1. Click the Edit Styles radio button in the CSS Styles Panel. 

Then click the Edit Style Sheet icon  at the bottom of 
the CSS Styles Panel..  

2. The Edit Style Sheet dialog box opens 
3. Select the external style sheet lessonstyles.css from the list 

and click Edit.   
The dialog box appears with a list of all the styles contained 
in this external style sheet. In this case, all the styles are 
redefined HTML tags.  

4. Select p from the list to edit the paragraph tag and click Edit. 
The attributes of that style are displayed in the Style 
Definition area of the lessonstyles.css dialog box. 

Dreamweaver/MX-stylesheets.doc  Page 7 
Technology & Learning Services, Cal Poly 



 
5. In the Style Definition dialog box, change the size from 10 points to 11 points by typing 11 in 

the Size text box.  
6. Change the Line Height to 18. Click OK in the Style Definition dialog box. click Save. 
7. Then click Save in the Edit Style Sheet dialog box. 
8. Save your work. 

Your changes are applied to the document. The font size is now slightly larger, and the space 
between each line of text is greater. This style sheet is not yet linked to any other documents; if 
other documents were linked to this style sheet, any text in those documents using the <p> tag 
would be formatted according to the modifications you just made. 

Creating Custom Styles 
Custom styles give you more specific control over the formatting of your document. You apply 
custom styles the same way you apply styles in a word processor: by selecting the text and then 
applying the style. You can apply the style to blocks of text or to individual words within the text. 
When you create a custom style, you do not have to preselect tags. You only select the text in order 
to apply the style to it, after the style has been created. Custom styles can be created in either 
external or internal style sheets. 
1. In the about.html document, click 

New Styles button . The New 
Style dialog box appears. 

2. Select Make Custom Style from the 
Type area. The text box that displayed 
tags in the previous exercises now 
becomes a Name text box for creating 
a custom style. Dreamweaver assigns 
generic names automatically in 
numeric order. This is not very 
descriptive, and they can be especially 
unhelpful when you create multiple c
styles short, descriptive names. 

ustom styles. It is best to get in the habit of giving your 

3. Type .boldit in the Name text box for the name of your custom style. A period before the name 
is required. 

4. The Define In area should still show .lessonstyle.css. Click the OK button 
5. Change Weight to bold and pick a dark red color from the Color drop-down menu. Then click 

OK. 
You’ll see the custom style you just created displayed on 
the CSS Styles panel. Only custom styles are displayed in 
this panel because they are the only styles for which you 
can select text in the document window and apply a style. 

6. Select Jacob Brown’s name and click the boldit custom 
style on the CSS Style Panel.  

7. If necessary, click the Apply Styles radio button. 
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The selected text changes to reflect the boldit style. There are now two styles affecting this text; the 
first style applied which redefines the <dl> (definition list) tag, and the custom style – the second 
style applied – which specifies bold and color formatting. When you apply more than one style to 
the same text, those styles might conflict and produce unexpected results. Browsers apply style 
attributes according to the order in which styles are applied and the following rules. 

The Rules 
RULE #1 - CSS is applied in an ordered sequence. When two or more styles are applied to the same 
text, the browser will display the attributes of each style in combination with each other. 
RULE#2 – If there is more than one style applied to the same text with conflicting attributes, the 
browser uses the specifications from the innermost style (the style closest to the text itself). The 
most recent styles are nested inside earlier styles. Since the last formatting attributes you apply are 
physically the closest tags to the text, they take precedence over earlier styles and control the final 
look of the text. The order of styles is as follows: 
External styles (this is the style that is farthest away from the text). 
Embedded styles (sometimes known as internal styles). 
Custom styles applied to text on the page. 
Local formatting, such as bold or italics, applied to text on the page from the property inspector 
(that is the style that is closet to the text). 
RULE #3 – If you have an external style sheet containing redefined HTML tags linked to your 
document, those styles are applied across your document. Suppose, for example, the external style 
sheet has definitions for heading 3 and heading 4, and that you’ve also created an embedded style 
within your document that redefines the heading 3 tag. The embedded style takes precedence if the 
attributes conflict with those in the external style. 
RULE #4 – Text formatting applied manually to ranges of text can also take precedence over styles. 
Suppose, in the example just presented, that you’ve used the property inspector to apply a different 
color on one of the heading 3 lines. That is local formatting, and it overrides other styles if they 
specify color as well. However, the attributes from custom styles overrule attributes from HTML 
tag styles. To make sure that your styles control the formatting for a paragraph, you may need to 
remove all other formatting settings if they conflict. 
Repeat step 6 for the remaining guide names in the list. Note that the text inherits additional font 
formatting from the style you defined previously for the paragraph. 
Save the document. 
NOTE: After you apply a custom style, you might want to remove the style. If you apply the custom 
style to the entire paragraph, make sure the insertion point is in the paragraph, and then click None 
on the CSS Styles Panel. The style and its formatting are removed. If you’re removing the custom 
style that has only been applied to selected text within a paragraph, make sure the insertion point is 
within a word that uses the custom style, and then click None on the CSS Styles panel. 
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Creating CSS Selector Styles for Links 
CSS Selector styles enable you to format combinations of tags – tags that appear within other tags. 
In this exercise, for example, you want to give text paragraphs within a table a different format than 
other paragraphs on the page. Since you already created a style for the <p> tag, the paragraphs 
within the table currently reflect that formatting. Place the cursor in a paragraph within the table, 
and you will see by looking at the HTML code that there are <td> tags for the table cell and <p> 
tags for the paragraphs within the cell. The tag selector at the bottom left of the document window 
shows you the hierarchy of the code: <body><table><tr><td><p> - body, table, table row, table 
cell, and paragraph, respectively. 
In this exercise, you will create a style that changes only the formatting of the paragraphs within the 
table cells so they look different from the rest of the paragraphs on the page. 

1. In the about.html document, click New Style button  on the CSS Styles panel. 
2. Select Use CSS Selector in the Type area and type td p in the Selector text box. 
3. Select lessonstyle.css in the Define In area and click OK. 
4. Set the font to Geneva, Arial, Helvetica, san-serif. Select 10 points for the Size and 14 

points for the Line Height.  
5. From the color box, choose a dark green and then click OK.  

Your changes are reflected in the text that is located in the table. 
6. Save your changes and close the file. 

Because CSS selector styles allow you to format tags that appear after another tag, the changes 
you made for the paragraph in the table do not affect the other paragraphs on the page. The text 
in the table uses a <p> tag, which appears after the <td> tag in the HTML code, so the td p CSS 
selector style is applied to that text. The paragraphs outside the table, however, do not have a 
<td> tag that appears before the <p> tag, so that text remains unaffected by the selector style. 

Linking to an Existing External Style Sheet 
You now have an external style sheet with several Style Definitions. Because it is external, you can 
link to this file from other documents. The Style Definitions, except for custom styles, will be 
applied automatically to all documents that are linked to this style sheet. You will need to manually 
apply any custom styles to paragraphs or selected text. 
1. Open the biking.html file. 

2. Click the  Attach Style Sheet button  at the bottom of the CSS Styles panel. The Select 
Style Sheet File dialog box opens. 

3. Locate the lessonstyles.css file you created earlier, and click Select. The external style sheet 
has now been linked to this document. Any tags in the current document are changed to the 
styles in the external style sheet. 

4. Notice that not all the text in biking.html has changed from its default formatting. The 
document had some HTML tags that were not included in your style sheet. In the following 
steps, you will edit the external style sheet to add the HTML tags that appear in this new page. 

5. Click Edit Style Sheet at the bottom of the CSS Styles panel. Add styles with format attributes 
of your choice for the heading ‘Mountain Biking Adventures’ and the bullet lists that appear 
on the page. Use the steps you learned in the Adding a Style to an Existing Style Sheet exercise. 
The text on the page changes as you specify styles for the heading and bullet list. 
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6. Use the steps you learned in the Creating Custom Styles exercise earlier to apply the boldit 

custom style to the definition terms, starting with ‘Horsethief Bench.’ 
7. Save the file. 

Creating Embedded Styles 
Embedded styles are used only in the current document. If you want to create Style Definitions for 
only one page in your site, you should create an embedded style. If you want your site to have a 
consistent look, you should use an external style sheet and link that style sheet to each document. 
1. In the biking.html document, click New Style 

on the CSS Styles panel. The New Style 
dialog box opens. 

2. Select This Document Only in the Define In 
area and change the Type to Make Custom 
Style (class).  
The ‘This Document Only’ specifies that you 
are adding a new embedded style. 

3. Type .highlight in the Name text box. 
4. Click the OK button. 
5. In the Style Definition box, click Background in the Category list on the left. Change the 

colors in the Background Color field to pale yellow and click OK. 
6. The highlight custom style you just created appears in the CSS Styles panel. There are now two 

custom styles: boldit and highlight. Notice the icon to the left of each name. The custom style 
in the external style sheet (boldit) has a small link image on the icon to represent the link to the 
external style sheet. 

7. Select Compass Adventure Travel on the first line below the Mountain Biking Adventures 
heading at the top of the page and click highlight on the CSS Styles panel to apply the style. 
The text appears to be highlighted with the pale yellow color. 

8. Save your file, and open the about.html file.  
9. Look in the CSS Style panel. You will not see the highlight custom style you just created 

because it is an embedded style and appears only in the document where it was created. 
NOTE: To remove embedded or external styles, click the Edit Style Sheet icon on the CSS Styles 
panel to open the Edit Style Sheet dialog box. Select the style you want to remove and click 
Remove. If the style is an embedded style, it is deleted form the document. If you remove an 
external style sheet, the link to the style is removed from the document. The actual external style 
sheet file is not deleted from your site. 
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Converting Embedded Styles to External Styles 
If you have a document with all embedded styles and you decide you want to use those styles in 
other pages, you can easily export those styles to an external style sheet. 
1. In the biking.html document, choose File > Export > CSS Styles. The Export Styles as CSS 

file dialog box opens. 
2. Name your style sheet bikingstyle.css and click Save. An external style sheet is created from 

the internal styles in the current document. 
3. If you want to use this external style sheet in your current document, first remove all internal 

styles, and then click the Attach Style Sheet button of the CSS Styles panel to link to the 
external file you just created. 

Converting CSS to HTML 
CSS is a great way to control the text throughout your web site, but not all browsers are capable of 
displaying CSS. Earlier browsers will ignore CSS formatting. If you decide to use CSS, you may 
want to convert your page to 3.0 browser-compatible files in order to display the page with 
formatting as close to the CSS styles as possible. You can then use the Check Browser behavior to 
redirect users based on their browser version. 
1. In the about.html document, choose File > Convert > 3.0 Browser Compatible.  

The Convert to 3.0 Browser Compatible dialog box opens.  
2. Select CSS Styles to HTML Markup and click OK. 
3. Save the file and close it. 

The converted file is opened in a new, untitled document and your original file remains 
unaltered. The styles that were applied in the about.html document are reproduced as closely 
as possible using standard HTML tags. However, it is not possible to convert some types of 
CSS formatting to HTML tags. For example, line height – also known as leading – has no 
equivalent in HTML. In other words, there is no way to adjust the spacing between lines of text 
with the standard HTML formatting attributes. Any attributes that cannot be converted will be 
discarded. 
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